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   خود در مورد مطالب آن شنهادیلطفاً هرگونه انتقاد و پ فایل؛  نیا تیفیدر جهت بهبود ک  ؛یخواننده گرام

 : دیینما مطرح  ر یزو یا با شماره تلفن   لیمی اآدرس گزارش مشکل را به یا و 

    soal@iranestekhdam.irآدرس ایمیل:                       021-91300013شماره تلفن تماس: 

http://www.iranestekhdam.ir/


 
 

 

 

 

 

 »محصولات مرتبط دانلودي « 

 ه ییاستخدام قوه قضا یو تخصص  یدانلود نمونه سوالات عموم

 خرید  و دانلود

   یاستخدام  يهادر آزمون  یآمادگ يبراهاي آموزشی دانلود درسنامه

 خرید  و دانلود

 

 

 »محصولات مرتبط چاپ شده « 

 هاي  استخدامی هاي چاپ شده براي آمادگی در آزمون سفارش کتاب 

 و سفارش  ثبت

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D8%AF%D8%B1%D8%B3%D9%86%D8%A7%D9%85%D9%87-%D9%87%D8%A7%DB%8C-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C
https://ketab.iranestekhdam.ir/
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اول: خش ب  
 

I.C.D.Lهفتگانه  يهااطلاعات و مهارت يفناور
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 شود؟ ی نصب نم  یبرد اصل يکدام جزء بر رو وتر، ی کامپ ستمیس  کیدر  -1

)www.iranestekhdam.ir ( 

 ه ی) منبع تغذ 2    ي ) واحد پردازنده مرکز 1

 RAM) حافظه  ROM    4) حافظه  3

 

 ) www.iranestekhdam.ir( ست؟ی«هرتز»، واحد چ -2

 سخت  سکی) سرعت انتقال داده به د1

 ی حافظه جانب ک ی) سرعت انتقال داده به 2

  ه یداده شده در هر ثان شینما ي ها کسلی) تعداد پ3

 CPU) سرعت 4

 

 ) www.iranestekhdam.ir( متفاوت است؟ گر، ی کدام مورد، با موارد د  -3

 ) ماوس 2     ) چاپگر1

 ) اسکنر 4     ي ) قلم نور3

 

  ن ی در پوشه ا  ری از انواع ز  ییها  لی فا،   퐖퐢퐧퐝퐨퐰퐬 7  عامل  ستمیس  يبرنامه بر رو  کیپس از نصب    -4

 برنامه خواهد شد؟  يموجب اجرا لی کدام نوع فا يبرنامه قرار خواهند گرفت. اجرا

)www.iranestekhdam.ir ( 

1 (File Folder    I- Application      

2 (GIF File     II-   GIF File     

3  (Icon     III-  Icon    

4 (Application    IV- File folder    

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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پنجره فعال،   نیفقط از هم  دیخواه  یپنجره فعال باشد. م  کی،  Windows  طیدر مح   دیفرض کن  -5

 ) www.iranestekhdam.ir(  د؟یریگ یکمک م  ر، ی. از کدام مورد زدیکن هیعکس ته کی

1 (File > print    2 (Ctrl + P 

3 (Alt + Print Screen   4 (Ctrl + F 

 

 پوشه انتخاب شده، مناسب است؟  ای لی فا کیدادن نام  ر ییتغ يبرا د، یکدام کل -6

)www.iranestekhdam.ir ( 

1  (F1      2  (F5  

3  (F2      4  (F9 

 

عدد    کی  ر، یکلمه «شهر» در عبارت ز  يشده پس از جستجو  افتی  ج ی، تعداد نتاWord  افزاردر نرم  -7

 ) www.iranestekhdam.ir(  انتخاب شده است؟  Findبوده است. کدام مورد در پنجره 

در    نی داشته است. ا  شی در سطح شهرها و شهرستان ها افزا  یعلم   سراهايتعداد کتاب   ، یطور کل  «به

 شود».  می بسته سراکتاب  کیاست که در شهر تهران، روزانه   یحال

1 (Find Whole Words Only  2 (Use Wild Cards 

3 (Match Prefix    4 (Match Case 

 

 ) www.iranestekhdam.ir(  کدام مورد است؟ معناي به کش، خط  در، علامت Word افزاردر نرم -8

 شده در سند می تنظ ي هاTab) 2   شده در سند  می تنظ  هی) حاش 1

 نماЇمکان  تی) موقع4    درج شکل   تی) موقع3

 

 شود؟ یداده ها از کدام مورد استفاده م یکیگراف شی نما ي، برا퐖퐨퐫퐝 2007 طیدر مح  -9

)www.iranestekhdam.ir ( 

1 (Table     2 (Clip Art   

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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3 (Smart Art     4 (Chart 

 

  ي ، کدام حالت ترازبند "퐉퐮퐬퐭퐢퐟퐲"در حالت    ي، قرار دادن ابزار ترازساز퐖퐨퐫퐝  2007سند    کی در    -10

 ) www.iranestekhdam.ir(کند؟  یم جادیرا ا

 ) دوطرفه 2     ) از چپ1

 ) از راست4     نچی) وسط 3

 

کاربرگ چاپ شود، از کدام ابزار استفاده   یکاربرگ در موقع چاپ، در اندازه واقع کی  میاگر بخواه -11

 ) www.iranestekhdam.ir( شود؟یم

1 (Scale     2 (View > Custom Views 

3 (View > Zoom to selection  4 (Size 

 

 ) www.iranestekhdam.ir(، کدام است؟ 퐄퐱퐜퐞퐥 2007 طیدر مح  Print Areaکاربرد ابزار  -12

 کاربرگ   ک یموجود در   يشده از داده ها جاد ی) چاپ نمودار ا1

 Excel  لیفا ک یکاربرگ از   کی  صفحه-به صفحه  شنمایش ی) پ2

 گرفتن  نتیپر ي از کاربرگ برا یمحدوده مشخص کی ) انتخاب 3

 محدوده ممکن جهت چاپ  نتری بزرگ نیی) تع4

 

 ) www.iranestekhdam.ir( شود؟ یظاهر م ?NAME# يخطا ر، یاز موارد ز  کیدر کدام  -13

1  (= 푠푢푚 (퐴2 퐴5)    2( = 푠푢푚 (퐴2, 퐴5) 

3  (= 푠푢푚 (퐴2: 퐴5)    4  (= 푠푢푚 (퐴2퐴5) 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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سطر کاربرگ در تمام صفحات تکرار شود، از    نی ، اولExcel  لیفا  کیبه هنگام چاپ    دیاگر بخواه  -14

 ) www.iranestekhdam.ir( د؟یر یگ یکدام ابزار کمک م

1 (Page Layout > Print Titles  2 (Home > Cells > Format 

3 (Data > Text to Columns  4 (Home > Wrap Text 

 

  ر، ی، از کدام مورد زPower Point 2007  لیفا   کیاز    دیاسلا   کیستاره در    کی شکل    می جهت ترس  -15

 ) www.iranestekhdam.ir( د؟یریگ یکمک م

1  (Insert > Picture    2  (Insert > Word Art 

3  (Insert > Clip Art    4  (Insert > Shapes 

 

  د یبخواه  شینما  نیدر ح  دی. فرض کندایکرده   جادی ا   دیاسلا   52شامل    Power Point  لیفا  کی   -16

 راه، استفاده از کدام ابزار است؟  نتری¬داده نشود. مناسب شینما  13و  12، 10 يدهایاسلا 

)www.iranestekhdam.ir ( 

1 (Custom Slide Show   2 (Setup Slide Show 

3 (Hide Slide     4 (From Current Slide 

 

 قابل انجام است؟  ر، ی از موارد ز  کیرکوردها براساس کدام  سازي، مرتب Access طیدر مح  -17

)www.iranestekhdam.ir ( 

I حروف الفبا .   IIعدد .   IIIو زمان خ ی. تار 

1  (I  ،II   وIII     2  (I    وII  

3  (II  وIII     4  (I    وIII 

 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 کنند؟  یخود استفاده م ینترنت ی آدرس ا ياز کدام دامنه برا یدولت يبه طور معمول، سازمان ها -18

)www.iranestekhdam.ir ( 

1 (edu      2 (gov  

3  (com     4 (org 

 

م  -19 مورد،  دل  یکدام  برخ  لیتواند  ثبت  سا  یعدم  در    يها  تیاز  شده  مرورگر    Historyمشاهده 

Internet Explorer  باشد؟)www.iranestekhdam.ir ( 

 In Private Browsing) استفاده از Proxy    2) استفاده از 1

 ) درج دامنه اشتباه 4   سرور  ي ها از رو تی) حذف سا3

 

 است؟  يورود ياز نوع پوشه ها ل، ی میا يحساب کاربر کی کدام پوشه در  -20

)www.iranestekhdam.ir ( 

1  (Outbox   وSpam/Junk   2  (Inbox    وTrash 

3  (Inbox    وSpam/Junk   4 (Trash    وOutbox 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 I.C.D.Lهفتگانه  يهااطلاعات و مهارت  يفناورپاسخنامه تستی سوالات 

 

 گزینه صحیح  شماره سوال  گزینه صحیح  شماره سوال 

11سوال  2   1سوال   4 

2سوال  12سوال  4   3 

3سوال  13سوال  1   4 

4سوال  14سوال  4   1 

5سوال  15سوال  3   4 

16سوال  3   6سوال    3 

7سوال  17سوال  1   1 

8سوال  18سوال  2   2 

9سوال  19سوال  3   2 

10سوال  20سوال  2   3 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE


 

 

 

 

 

 

 

 

 

 

 

 

دوم: خش ب  
 

سی فار اتیزبان و ادب
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 ) www.iranestekhdam.ir(  کدام واژه، در مقابل آن «غلط» آمده است؟ یمعن -1

  ) گردون: فلک 2    ي ) مسخّر: دشوار 1

 ر ی) فرتوت : پ4  ی جانوران وحش ی) کنام: محلّ زندگ 3

 

 ) www.iranestekhdam.ir(کدام است؟  ب، یشب رو» به ترت -«وصُلت   يواژه ها  یمعن -2

 داربی  شب –  محکم) 2    نگهبان  –) ارتباط  1

 راهزن  –   یوستگ ی) پ4    ک کشی –   وند ی) پ3

 

 ) www.iranestekhdam.ir( شود؟ یم افتی  »ییدر کدام گروه کلمه، «غلط املا -3

 نقاهت دوران   –  ي ریرپذ یو تأث  يرگذار تأثی) 2     انزوا  و  عزلت –   عیبد  ن ی)  مضام1

 ذمّت و تعهّد  - ) طبقه مرفه4  قواعد و ضوابط  -  یالمثنّ  ی) درخواست3

 

 ) www.iranestekhdam.ir( وجود دارد؟  »ییدر کدام عبارت ،«غلط املا -4

 شتر را با تو چه مناسبت است و تو را بدو چه مشابهت. ه، یسف ي) گفت ا 1

 از بند گرانم خلاص کرد.  د،یهفته که مژده سلامت حجاج برس  نی) در ا2

 اتفاق سفر افتاد.  ارانی يا  فه ی) در آن قربت، مرا با طا3

 . ییگو  استیو ترك ر  یکه ملک قناعت را هراست کن  نم ی) پس مصلحت آن ب4

 

 ) www.iranestekhdam.ir(  است؟ »یزاکان دیاز آثار معروف «عب یک ینام  ر، یکدام مورد ز  -5

 نبود  ی کیبود،  ی کی) 2       ياد ی) زن ز1

 ارسلان  ر ی) ام4     ) موش و گربه 3

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 ) www.iranestekhdam.ir( است؟   »یمیکدام اثر، از «نادر ابراه  -6

 شکر است ی ) فارس 2    ) آتش بدون دود 1

 ن یزم نی) نفر4    پر ملال  ي ) دهکده 3

 

 ) www.iranestekhdam.ir(کدام است؟  ر، یز ت یدر ب هیقاف يواژه ها -7

 از هزار بپرس و ز من مپرس»  دنینال  گل ز خار بپرس و ز من مپرس  «احوال

 بپرس  -) بپرس 2   من مپرس   -) من مپرس 1

 ز من مپرس  -) ز من مپرس  4     هزار  - ) خار 3

 

 ) www.iranestekhdam.ir( اند؟سروده شده  یدر چه قالب  ر، یز اتیاب -8

 م» یدر راه شرف از دل و جان کوش   م یباده عزت و جلالت نوش «ما

 م» ی نفروش  یرا به بندگ  يآزاد    می در صف رزم، جامه بر تن پوش «گر

 ی ) رباع2     ی تی) دو ب 1

 ) قطعه 4     ) چهار پاره 3

 

 ) www.iranestekhdam.ir( دارد؟  هام»یکدام واژه «ا ر، یز  تیدر ب -9

 دلم به زحمت مردم رضا نبود»  نیمسک    یدل ول  نی به بال ده ینخفت د «دوشم

  ده ی) د 2      ) رضا 1

 ) مردم 4          ) دوش 3

 

 ) www.iranestekhdam.ir( کدامند؟  ر، یز  تیب يها  هیآرا -10

 دار» یو نرگس ب یباشد که تو در خواب  فیح ش یآخر چو بنفشه سر غفلت در پ یک «تا

 هامای  –  پارادوکس  –   استعاره) 2   تضاد  –  ه تشبی –   هی) کنا1

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 تضاد  –  ه کنای  –  هامی) ا4     هکنای –  پارادوکس  –   هی ) تشب3

 

 ) www.iranestekhdam.ir(  ست؟ی از چ  هی«آب از چشم گرفتن» کنا ر، یز  بتیدر ب -11

 چشم تو آب چشم ز آهو گرفته است»   ست یگر رمد از خلق دور ن ده یگز «مرد

 کردن   هودهی) کار ب2     ) ترساندن 1

 ستنی) گر4    ی بدبخت تی) نها3

 

 ) www.iranestekhdam.ir(  دارد؟ ریز  تیب رینظ یمفهوم ت، یکدام ب -12

 به چنگ»  هیهرگز نکند درّ گرانما  کند کام نهنگ  شهیگر اند  «غّواص

 به سامان غم مخور  د یباز آ دهیسر شور نیو حالت به شود دل بد مکن دهیدل غمد  ي ) ا1

 نباشد حال دوران غم مخور  کسانیدائماً   بر مراد ما نرفت  ي ) دور گردون گر دو رو2

 پنهان غم مخور  ي ها ي باشد اندر پرده باز ب یاز سرّ غ ي چون واقف نه ا د ی) هان مشو نوم3

 غم مخور  لانی سر زنش ها گر کند خار مغ  زد قدم  ی گر به شوق کعبه خواه  ابانی) در ب4

 

 )www.iranestekhdam.ir( تفاوت دارد؟  ات، یاب ریبا سا تیمفهوم کدام ب -13

 سرخم بگفت و چهره زردم  دهیکه آبِ د عشق و چه حاجت ث یحد  می) نخواستم که بگو1

 مت یگم گشت در تو هر دو جهان از که جو  مت ینشانِ محض نشان از که جو ی ب ي ) ا2

 ده یو رخسار زرد و رنگ پر د یکه اشک گو تو ما را   شی) چه حاجت است به اظهار عشق پ3

 رازم  يچشمِ تَر دامن اگر فاش نکرد   پنهان يبماند  نه یتو در س  ي ) سرّ سودا4

 

 )www.iranestekhdam.ir( دارد؟  یارتباط مفهوم ت، یبا کدام ب ر، یز  تیب -14

 گرچه او بالاتر است»  رد، ی چشم ابرو نگ يجا ست یکسر شأن شعله ن ند، یاگر بالا نش «دود

 کند باران را   شه یچه اند  لیغرقه در ن   هات ینترسد ه ر یاز سرزنش غ ي) سعد 1

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 بر سنگ  نیآهن خینرود م  دل چه سود خواندن وعظ  ه ی) بر س 2

 نخواهد شد  ایرسد توت دهیاگر به د  شد که غبار  زیشد عز نی) نه هر که صدرنش3

 گر هست  يباغبان راست غصه ا   چه غم که شاخ شکست ن ی) باغ را ب4

 

 ) www.iranestekhdam.ir(  دارد؟ شیرا یبه و  ازیکدام عبارت، ن -15

 بالاتر است. ای) هنگام مدّ، آب در2   .  دمی را د نالی مسابقه ف ن ی) آخر1

 است. امده یهنوز بر ن د ی) خورش 4  کند. یوقت دست از پا خطا نم  چی) او ه3

 

 ) www.iranestekhdam.ir(دارد؟   شیرا یبه و  ازیکدام عبارت، ن -16

 دشوار است. یگذشته، اندک  ی) زبان متون ادب 1

 ساده و قابل فهم باشد .  د ی) زبان نوشته، با2

 دارد.   فای) او روز گذشته از سمت خود است3

 گردد.  ی منعقد م شتر یب ایدو نفر   نیاست، که ب ی) تعهّدنامه از اسناد رسم4

 

 ) www.iranestekhdam.ir(  دارد؟ »ی کدام عبارت، «کژتاب -17

 ) آفتاب روشن در پرده نخواهد ماند.1

 .ستین ی بزرگ خال ي از آدم ها یدوران   چی) ه2

 .استیشناخت دن ییتوانا ، یآدم ي روین نی) برتر3

 ام، سلام کردم.  ه ی) به دوست همسا4

 

 ) www.iranestekhdam.ir(واژگان تفاوت دارد؟  ریساختمان کدام دو واژه، با سا -18

 دانشکده   – شاخسار) 2    دار  خزانه  –   مردی) پا1

 جنگجو  –   کدلی) 4    پاش  گلاب   –  ری) شه3

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 )www.iranestekhdam.ir( کدام واژه ها، متفاوت است؟  ییمعنا يرابطه  -19

 بیو قر د بعی –  نیو مه ن ی) که2     روزي و  رزق –  ری) فرتوت و پ1

 کو یو ن  فلطی –  د ی) مهر و خورش 4  و با ارزش   هگرانمای  –) فروزان و تابان  3

 

 ) www.iranestekhdam.ir( هم خانواده «غلط» آمده است؟  يدر کدام گروه، واژه ها  -20

   رتیبص  -) مبصر  2       زعزی – ) عزّت  1

 مغتنم  –  ی ) غن4     قرائت  -  ر ی) تقر3

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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  و ادبیات فارسیزبان  پاسخنامه تستی سوالات 

 

 گزینه صحیح  شماره سوال  گزینه صحیح  شماره سوال 

11سوال  1   1سوال   1 

2سوال  12سوال  4   4 

3سوال  13سوال  -   2 

4سوال  14سوال  4   3 

5سوال  15سوال  3   1 

16سوال  1   6سوال    3 

7سوال  17سوال  3   4 

8سوال  18سوال  2   3 

9سوال  19سوال  4   2 

10سوال  20سوال  1   4 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE


 

 

 

 

 

 

 

 

 

 

 

 

سوم: خش ب  
 

معارف اسلامی



 

 
  

  کلیک کنید قوه قضاییهنمونه سوالات استخدامی  بسته کامل و ویژه  دانلودبراي  19

 « وفَِی الْأَرضِْ آیَاتٌ لِلْموُقِنِین وَفِی أَنْفسُِکُمْ أفََلاَ تُبصِْرُونَ » به کدام موضوع اشاره دارد؟  فهیشر  هیآ -1

)www.iranestekhdam.ir ( 

 است.  یمقدمه خدا شناس   نیدر زم  ری) س 2  است.  یمقدمه خود شناس  ی) خدا شناس 1

 است. یمقدمه خداشناس  ی) خودشناس 4  است.  ی) معرفت نفس مقدمه خودشناس 3

 

همواره،   اهانیکند که گ  ی م  ریچنان تدب  شیخو   تی :«خداست که با هدا  دیفرما  یکه م  دیقرآن مج   -2

 ) www.iranestekhdam.ir( ؟از برهان نظم اشاره دارد  ریکنند» به کدام تقر  دیگوارا تول  يها وه یم

 در کل عالم  ی) هماهنگ 2     ي ) هدفمند 1

 یی ) از موارد جز4    در کل عالم  ی ) طراح3

 

 ؟ شود  یمحقق م یها، اخلاص در پرستش و بندگ یژگ یبا وجود کدام و -3

)www.iranestekhdam.ir ( 

 حیو صورت صح   ی) حسن فعل 2      ی اله تیو ن ی ) حسن فاعل1

   د یو اثر مف  ی) حسن فعل 4    یو حسن فعل  ی ) حسن فاعل3

 

 www.iranestekhdam.ir(  شود، کدام است؟ یم یکه باعث سعادت آدم ین یراست  مانیا -4

 ي و آزاد  اریاز اخت یناش  مانی) ا2   توأم با عمل صالح  مانی) ا1

 همراه با تعقل و تفکر مانی) ا4 امبر یخداوند و رسالت پ تیبه وحدان مانی) ا3

 

کدام بعد از    انگریب  ب، یبه ترت   ن»ینستع  اكینعبد و ا   اكیو « ا   ن»ی الحمدالله رب العالم  فه«یشر   اتیآ  -5

 ) www.iranestekhdam.ir(  هستند؟ دیابعاد توح

   عبادي –  ي ) عباد2    ي عباد  -ی ) افعال1

   افعالی –  ي ) عباد4      افعالی –  ی ) افعال3

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE


 

 
  

  کلیک کنید قوه قضاییهنمونه سوالات استخدامی  بسته کامل و ویژه  دانلودبراي  20

 ) www.iranestekhdam.ir( ؟کامل کرد ر، یاز موارد ز کیرا با وجود کدام   تیخداوند نعمت هدا  -6

 خود   ي ایو اول  ای) انب2    اکرم(ص)  امبر ی) پ1

 ي و عقل بشر   ای) انب4    اولوالعزم  امبران ی) پ3

 

 ) www.iranestekhdam.ir(  ست؟یچ امبرانینبوت پ لیسند و دل  -7

 . افتی ی) معجزه که به درخواست مردم تحقق م 1

 شد   ی نازل م امبریخداوند، بر قلب پ يکه از سو   ی) وح 2

 بشر نازل شده است . تیهدا يخداوند، برا يکه از سو   ی) وح 3

 شد . ی ) معجزه که به اذن خدا انجام م4

 

 مقام نائل شدند؟  نیو چگونه به ا   ستیاکرم(ص) چ امبریمقام پ نیو بالاتر  نی برتر -8

)www.iranestekhdam.ir ( 

    یقرب اله ر یدر مس ی و بندگ  ت عبودی –   يمعنو  ت ی) ولا1

   ی اله تیو عنا  امبریخود پ یستگ یشا - يظاهر ت ی) ولا2

  ی قرب اله ر یدر مس ی و بندگ  تیعبود – يظاهر ت ی) ولا3

 ی اله تیو عنا امبر یخود پ یستگ یشا - يمعنو  ت ی) ولا4

 

در شان کدام معصوم    ت، یولا هیکند و آ  یمقام امامت را معرف  ستهیتواند فرد شا  یم  یتنها چه کس  -9

 ) www.iranestekhdam.ir(؟ است 

 حضرت محمد (ص)  -) خداوند متعال2  (ع)   علی حضرت –) حضرت محمد (ص)  1

 حضرت محمد (ص)  - ) حضرت محمد (ص) 4  (ع)  یحضرت عل  -) خداوند متعال3

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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حجت خود را  در هنگام تولد از نظرها پنهان کرد تا امامت در شکل  نیبه کدام علت، خداوند آخر -10

 ) www.iranestekhdam.ir(  ؟ابدیادامه  بت یو از پس پرده غ  دیجد

  در مورد حکومت  ی اله ي تحقق وعده ها ي مردم برا ی) عدم آمادگ 1

 شانیاز ا يدرك حضور و بهره مند  ي مردم برا یستگ ی) عدم شا2

 در جامعه توسط حکومت ها یعدالت ی) رواج گناه و ظلم و ب 3

 مردم و در خطر بودن جان آن حضرت   یو ناسپاس  ی) قدر ناشناس 4

 

خبر  داده اند که روز    یشهرت داشتند، به آدم   ییکه به راستگو  امبریهزاران پ  نکهیبا توجه به ا  -11

کند؟» به    اطیاحت   دیانسان نبا  ایاست، عبارت « آ   شی در پ  گرید   ییایتکان دهنده و دن  يو واقعه ا  میعظ

 ) www.iranestekhdam.ir( کدام برهان معاد اشاره دارد؟

  تی) معقول 2     ) حکمت1

 ) فطرت 4     ) عدالت 3

 

الْمتَُّقِینَ   فهیشر   هیاز آ   -12 نَجْعَلُ  الْأَرْضِ أمَْ  الصَّالِحَاتِ کَالْمُفسِْدیِنَ فِی  الَّذِینَ آمَنوُا وعََمِلُوا  نَجعَْلُ  أمَْ   »

 ) www.iranestekhdam.ir(  ؟م یبر یم یکَالْفُجَّارِ» به کدام موضوع پ 

   ی) امکان معاد در پرتو حکمت اله2  ی ) ضرورت معاد در پرتو عدل اله1

 ی) امکان معاد در پرتو عدل اله4    ی) ضرورت معاد در پرتو حکمت اله3

 

کدام   انگری» ب  دیدانست  یکاش م   يآخرت است ا  يهمانا در سرا   یقیحق  ی« زندگ  فهی شر  هیترجمه آ   -13

 ) www.iranestekhdam.ir( موضوع است؟

 ي اخرو ی بودن زندگ یق یو حق ایدن  ی بودن زندگ ی واقع ر ی) غ1

 ی همراه با معاد روحان  ياخرو  ی زندگ ی ) جاودانگ 2

 یهمراه با معاد جسمان  ياخرو  ی زندگ ی ) جاودانگ 3

 کمال است. ي لکن دارا است،یدن ه یشب بایتقر   ياخرو  اتی) ح4

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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کنند که   یرسد، آرزو م   یمرگشان فرا م ی وقت ، یانجام دادن چه عمل  ي و برا  ی چه کسان ب، ی به ترت -14

 ) www.iranestekhdam.ir(  م؟یگشت یبر م ایکاش به دن يا

 اعمال صالح - ) کافران و تبهکاران2     یتوبه واقع  -  ) همه انسان ها1

   یتوبه واقع  - ) کافران و تبهکاران4   اعمال صالح   -  ) همه انسان ها3

 

گردد   یوارد محشر م  ی: « هر انساندیفرما  یم  زیاز شاهدان رستاخ  کیدر مورد کدام     میقرآن کر  -15

 ) www.iranestekhdam.ir(  ؟است» يدهنده ا  یکه همراه او سوق دهنده و گواه  یدر حال

 ی اله امبران ی) پ2     ) اعضا و جوارح 1

 اسلام(ص)  امبر ی) پ4     ) فرشتگان 3

 

آ  -16 ترجمه  از    فه یشر   هیاز  در حق  ادی« هر کس  بگرداند،  تنگ خواهد    یزندگ  قت، یمن( خدا) دل 

 ) www.iranestekhdam.ir(  ؟شود یم افتیدر ریداشت» کدام مفهوم ز

  است. یروان ي غلبه بر اضطراب ها يبرا ی پشتوانه مستحکم نی) د 1

 نائل گردد .  يو اخرو   يو یتواند به سعادت دن یخداوند م  ادی) انسان با 2

 است. ی اله امبرانیپ می بحران اخلاق در انسان، غفلت از خدا و تعال شهی) ر3

 اخلاق بوده و هست. ي برا یهمواره پشتوانه مستحکم نی) د 4

 

 شیدهد، مگر آنان خود، حال خو ینم رییرا تغ یخدا حال قوم قت، ی« در حق  فهیشر  هیاز ترجمه آ -17

 )www.iranestekhdam.ir( ؟شود   یم افتیدهند»، کدام  مفهوم در رییرا تغ 

 به آنها توجه کرد .  د ی باشد که با یم  ی عموم يو سنت ها  نیو تحول در امور مربوط به جامعه، قوان  ریی) تغ1

 از افراد جامعه است.  ی و همه جانبه گروه ي عدالت در جامعه، منوط به مبارزه جد  ي) شرط برقرار 2

 آنان است. ينگر ی از سطح یرسد، ناش  یکه از ستمگران به مردم م  ییاز درد و رنج ها ي اری) بس3

 عموم افراد جامعه را لازم دارد .  یعدالت، همراه ي برقرار يشده، برا  یعدالت یکه گرفتار ب ي ) جامعه ا4

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 کند؟  یم یکسب عزت و کرامت را چگونه معرف یراه و روش اصل م، یقرآن کر -18

)www.iranestekhdam.ir ( 

 او   ي خدا و قبول فرمان ها ي) بازگشت به سو2  نکردن  ي روی پ یپست درون  لاتی) از تما1

 یانسان در کنترل شهوت جنس یی) توانا4 گرانینکردن و کوچک نشمردن د  ر ی) تحق3

 

  ياز فرزندانم را در دره ا   یکی :« پروردگارا من    دیفرما   ی(ع) ممیاز قول حضرت ابراه   میقرآن کر  -19

 ) www.iranestekhdam.ir(کشت، نزد خانه محترم تو، سکونت دادم، تا ..................... .»  یب

    .حق را به پا دارد نی) د 2    . ) خانه کعبه را آباد کند 1

 ) نماز را به پا دارد. 4    .) اطاعت خدا را کند 3

 

 ) www.iranestekhdam.ir(  خانواده، کدام است؟ لیهدف تشک  نی تر  یعال -20

  همسران  نیب ی از انس و هم صحبت ی) آرامش ناش 1

 در خانواده   تیمسئول  رش یپذ  ی) کسب آمادگ2

  خانواده  ي از اعضا کیهر   ي و معنو  ی) رشد اخلاق 3

   ینیو د  یفرزندان در همه ابعاد فرهنگ  ی ) رشد و بالندگ4

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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معارف اسلامی  پاسخنامه تستی سوالات   

 گزینه صحیح  شماره سوال  گزینه صحیح  شماره سوال 

11سوال  4   1سوال   2 

2سوال  12سوال  1   1 

3سوال  13سوال  3   1 

4سوال  14سوال  1   2 

5سوال  15سوال  2   3 

16سوال  2   6سوال    1 

7سوال  17سوال  4   4 

8سوال  18سوال  1   2 

9سوال  19سوال  3   4 

10سوال  20سوال  4   3 

 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C-%D8%B7%D8%B1%D8%AD-%D8%B4%D9%87%DB%8C%D8%AF-%D8%B2%DB%8C%D9%86-%D8%A7%D9%84%D8%AF%DB%8C%D9%86
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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Part A: Grammar and Vocabulary: 

Directions: Choose the word or phrase (1), (2), (3), 풐풓 (4) that best completes 

each sentence. Then mark the correct choice on your answer sheet. 

1- The man over there is a famous architect …………… designs won an 

International award last year. (www.iranestekhdam.ir ) 

1) whose     2) which 

3) who’s     4) whom 

 

2- David …… harder, but he was too lazy and that why he failed the exam. 

(www.iranestekhdam.ir ) 

1) should study    2) should have studied 

3) must have studied   4) must study 

 

3- Maryam showed her father the most recent picture …… by her little daughter. 

(www.iranestekhdam.ir ) 

1) that painted    2) painted 

3) was painted     4) it was painted 

 

4- The students bought some eggs and tomatoes …………… they would make 

an omelet. (www.iranestekhdam.ir ) 

1) as soon a     2) until 

3) so that     4) whether 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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5- “Would you mind …………… in the nonsmoking section?” the security guard 

said politely. (www.iranestekhdam.ir ) 

1) don’t smoke    2) not to smoke 

3) not smoke    4) not smoking 

 

6- Mary will certainly lose all her friends if she ……………. to talk about them 

behind their backs.  (www.iranestekhdam.ir ) 

1) continues    2) would continue 

3) continued    4) will continue 

 

7- While I was sitting at the café with my friends, I suddenly realized that I 

…………… the oven on at home. (www.iranestekhdam.ir ) 

1) was left     2) was leaving   

3) had left     4) have left 

 

8- Children seem to learn more interesting things …………… to when we were 

at school.  (www.iranestekhdam.ir ) 

1) observed     2) compared 

3) attached     4) investigated 

 

9- To stay competitive, they’ll have to increase product ………. as well as cutting 

prices. (www.iranestekhdam.ir ) 

1) excitement    2) treatment 

3) argument    4) development 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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10- According to eye …… the robbery was carried out by two teenage boys.  

(www.iranestekhdam.ir ) 

1) employers    2) laborers  

3) witnesses    4) partners 

 

11- Many important historical ………… were destroyed when the library was 

burned in fire. (www.iranestekhdam.ir ) 

1) missions     2) temperatures 

3) distances       4) documents 

 

12- My schedule is very ………… so I can arrange to meet with you any day next 

week. (www.iranestekhdam.ir ) 

1) mild     2) flexible 

3) global     4) aware 

 

13- The lawyer suspected that the judge was bribed to arrive at a guilty …… . 

(www.iranestekhdam.ir ) 

1) conflict     2) entity 

3) verdict     4) portion 

 

14- When you give a ……… everyone expects you to be telling the truth in 

whatever statement you are telling them. (www.iranestekhdam.ir ) 

1) testimony    2) controversy 

3) phenomenon    4) foundation 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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15- When you’re working such long hours, it is ……… that your marriage will 

start to suffer.  (www.iranestekhdam.ir ) 

1) significant    2) voluntary 

3) contemporary    4) inevitable 

 

Part B: Reading Comprehension: 

Directions: Read the following passage and select the 

퐜퐡퐨퐢퐜퐞 (1), (2), (3), 풐풓 (4) that best answers each question. Then mark the 

correct choice on your answer sheet.   

Criminal law distinguishes crimes from civil wrongs such as tort or breach of 

contract. The distinction between criminal law and civil law has existed 

throughout history. Criminal law has been seen as a system of regulating the 

behavior of individuals and group in relation to societal norms at large whereas 

civil law is aimed primarily at the relationships between private individuals and 

their rights and obligations under the law. Although many ancient legal systems 

did not clearly define a distinction between criminal law occurred in the late 

nineteenth century. In most North American law schools, the basic course in 

criminal law is based upon the English common criminal law of 1750. 

16- What is the passage mainly about?  (www.iranestekhdam.ir ) 

1) The importance of criminal law  

2) Law school in North America 

3) Differences between criminal law and civil law 

4) Criminal law in England 

 

17- The word “primarily” in line 4 means ……… . 

(www.iranestekhdam.ir ) 

1) previously    2) mainly 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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3) privately     4) frequently 

 

18- The word “their” in line 4 refer to …………… .   ( www.iranestekhdam.ir ) 

1) relationships    2) rights 

3)obligations    4) individuals 

 

19- Which of the following statements is true? (www.iranestekhdam.ir ) 

1) The codification of criminal law in England resulted in the distinction between 

criminal and civil laws. 

2) The codification of criminal law in England occurred in the late nineteenth 

century. 

3) The distinction between criminal and civil laws has never existed historically. 

4) Criminal law is a system of regulating the behavior of individuals and groups in 

relation to societal norms. 

 

20- The basic course in criminal law in most North American law school is based 

on the ……… . (www.iranestekhdam.ir ) 

1) English common criminal law of the mid-18th century 

2) English common civil law of the mid-18th century 

3) English common civil law of the mid-17th century 

4) English common criminal law of the mid-17th century 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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زبان انگلیسی عمومی پاسخنامه تستی   

 

 گزینه صحیح  شماره سوال  گزینه صحیح  شماره سوال 

11سوال  1   1سوال   4 

2سوال  12سوال  2   2 

3سوال  13سوال  3   3 

4سوال  14سوال  3   1 

5سوال  15سوال  4   4 

16سوال  4   6سوال    3 

7سوال  17سوال  3   2 

8سوال  18سوال  2   4 

9سوال  19سوال  4   4 

10سوال  20سوال  3   4 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE


 

  

 

 

 

 

 

 

 

 

 

 

پنجم: خش ب  
 

 یعموم يها يهوش و توانمند
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انتخاب کنید   4تا    1هاي  راهنمایی:  متن زیر را به دقت بخوانید و صحیح ترین پاسخ، را براي سوال 

 و در پاسخنامه علامت بزنید. 

هواداران   و  اجتماعی  دانشمندان علوم  براي  تنها  نه   ، میلادي  آغاز هزاره جدید  و  بیستم  قرن  پایان 

جنبش هاي هزاره اي ، که براي عموم مردم ، حاوي معانی و اشارات ضّد و نقیضی بود. بسیاري گمان   

ست: پایان هزاره  می کنند پایان هزاره باید آبستن تحولی جدید باشد . حال آنکه لزوماً این گونه نی

واقعاً دوران تحول است. بدون   نخست، بی هیچ حادثه اي سپري شد. با این همه ، پایان هزاره دوم، 

انقلابی ترین دوره تاریخ به سر می بریم و تغییر و تحول دائمی، به واقعیت انکار   تردید ما امروز در 

طول تاریخ  بشر، آهنگ تغییر اجتماعی  ناپذیر و اساسی حیات اجتماعی بدل شده است .عملاً در تمامی   

نسبتا کند بوده است و اکثر مردم، کم و بیش ، همان شیوه هاي زندگی پدرانشان را دنبال می کرده اند. 

حال آنکه امروزه بر عکس، ما در جهانی متحول و دستخوش دگرگونی چشم گیر و دائمی زندگی می  

دنیا  رویداد  انگیزترین  شگفت  که  قسمی  به  تغییرات   کنیم   سابقه  بی  سرعت  توان  می  را  معاصر  ي 

اجتماعی دانست. روند تغییرات اجتماعی چنان سرعت و عمقی یافته که پابرجاترین عرصه حیات بشر، 

یعنی فرهنگ را نیز در نوردیده و ما را در میانه یک دگرگونی جدي فرهنگی قرار داده است . تحولی  

ی ازکشف آتش تاکنون می داند . آنچه زمینه چنین  تغییر و  که بارلو آن را  جدي ترین  تحول فرهنگ

تحولات ژرف  و شگرفی را پدید آورده و این برهه از تاریخ  را واجد برجستگی و اهمیت فوق العاده اي  

ساخته، دستاوردهاي تکنولوژیک جدید و متاخر بشري است؛ دستاوردهایی که به عنوان تکنولوژي 

ارتباطی نوین  پارادایم  اطلاعات  -هاي  یک  استیلاي  از  خبر  برخی   ، رو  این  از  شوند.   می  شناخته  ی 

تکنولوژیک جدید می دهند که بر محور تکنولوژي هاي اطلاعاتی سازمان یافته است. حال اگر بپذیریم  

که دگرگونی در تکنولوژي هاي  ارتباطی موجب دگرگونی فرهنگی شده است ، باید به تاسی از مک  

تکنولوژي هاي جدید ارتباطی که تناسبی با فرهنگ پیشین ندارند، فقدان تجانسی  لوهان اذعان داریم  

نسبتاً بادوام می آفرینند. این فقدان تجانس با تاخر فرهنگی موجب پیدایی بحرانی فرهنگی می شود  

اطلاعاتی  -که همراه با دگرگونی هاي اجتماعی بروز و ظهور پیدا می کند.بدین ترتیب انقلاب ارتباطی

بیست و یکم با بهره گیري از تکنولوژي هاي نوین ارتباطی و اطلاعاتی و با فراهم آوردن پیدایی    سده 

«جامعه شبکه اي» که افراد و جوامع را در قالب هاي تازه، هویت هاي تازه بخشیده، نه تنها قواعد و  

و جهان  تغییر داده  قوانین حاکم بر ارتباط میان انسان ها، بلکه ایستار ما را نسبت به خود، دیگران  

است.به عبارت  دیگر، با در هم شکستن مرزهاي مرسوم گروهی و متعاقب آن، تغییر در برجستگی  

هویت   معناي  نتیجه  در  و  گروهی  هاي  بندي  مرز  اهمیت  و  روشنی  بر  تمایز،  و  تشابه  به  نیاز  نسبی 

 اجتماعی تاثیر گذاشته است. 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 ) www.iranestekhdam.ir(  موضوع اصلی متن فوق، کدام است؟  -1

 تحولات اجتماعی و فرهنگی قرن بیستم   )1

 اطلاعاتی   -تکنولوژي هاي نوین ارتباطی )2

 ) پیامدهاي تحولات اجتماعی و تکنولوژیک 3

 معانی ضد و نقیض تحول در عرصه هاي اجتماعی و فرهنگی )4

 

 ؟ بر اساس متن، کدام مورد در خصوص سرعت تغییرات اجتماعی، صحیح است -2

)www.iranestekhdam.ir ( 

 .آثار منفی در شیوه هاي زندگی انسان ها برجا گذاشته است )1

 تابعی از پیشرفت هاي تکنولوژیک عصر حاضر است.  )2

 از نظر بارلو،غیر قابل کنترل و آسیب زا است. )3

 از کشف آتش تاکنون، به طرز چشم گیري افزایش یافته است.  )4

 

 هدف نویسنده از اشاره کردن  به مک لوهان در پاراگراف دوم، کدام است؟  -3

)www.iranestekhdam.ir ( 

  مشروط نمودن نظر او در باره یک مقوله فرهنگی )1

 ارائه تعریف پدیده فقدان تجانس فرهنگی  )2

 ) استفاده از دیدگاه او در بیان نظر خویش 3

 ) معرفی او به عنوان یکی از صاحبنظران حوزه فرهنگ 4

 

 بر اساس متن، کدام مورد در باره رابطه بین دگرگونی هاي اجتماعی و فرهنگی ، صحیح است؟  -4

)www.iranestekhdam.ir ( 

 دگرگونی هاي فرهنگی در عصر حاضر، معلول سرعت گرفتن آهنگ  تغییرات اجتماعی است .  )1

 انقلاب تکنولوژیک از استحکام این رابطه تا حد قابل توجهی کاسته است. )2

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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 شواهدي دال بر وجود علت و معلولی بین آنها وجود ندارد .  )3

 ) در طول تاریخ  تغییرات اجتماعی همواره عامل بروز تغییرات فرهنگی ملموس بوده اند.4

 

بهتر است تیم سازنده فیلم« الف» براي ساخت فیلم بعدي، مخاطب را هوشمندتر از چیزي که می    -5

پندارند در نظر بگیرند و راه فیلم هوشمندانه تر چون «ب» را پیش بگیرند، چرا که مخاطب امروزي در 

 ی خواهد. کنار کشت و کشتار هیولاها و جلوه هاي ویژه بی نظیر، دلش یک داستان ناب و اصلی نیز م

 ) www.iranestekhdam.ir(د؟ توان به درستی از متن فوق استنباط کرکدام مورد را می 

 ) تیم سازنده فیلم «الف» مورد توجه خاص مخاطبینی قرار گرفت که عاشق جلوه هاي ویژه هستند.1

 ) این داستان و محتواي فیلم است که کشت و کشتار هیولا ها و جلوه هاي ویژه بی نظیر را باورپذیر می کند.2

) مخاطب هاي هوشمند، مادامی که داستان یک فیلم، ناب و واقعی باشد، اهمیت چندانی به هیجان و جلوه هاي  3

 ویژه نمی دهند.

 ) فیلم «ب» فیلمی است که طرح داستان آن قوي است. 4

 

مریخ نورد ناسا، تصویري را از سطح  سیاره سرخ ثبت کرده که نشان دهنده یک قاشق بزرگ و    -6

عجیب است. شکارچیان فرازمینی ها اعتقاد دارند که این قاشق، نشانه اي از وجود حیات در مریخ، در  

ور در سال هاي دور بوده است. همچنین این کشف می تواند فرضیه جان براندنبورگ ، دانشمند مشه

زمینه فضایی و فرا زمینی ها را تایید کند. براندنبورگ معتقد است که حیات هوشمند در مریخ، در  

 گذشته بر اثر یک جنگ هسته اي نابود شده است. 

 ) www.iranestekhdam.ir(  کدام مورد ، فرض لازم براي باورپذیري فرضیه جان براندنبورگ است؟

 ) قاشقی که مریخ نورد ناسا نشان می دهد، ساخته فتوشاپ است.1

 ) مواد لازم براي تهیه سلاح هاي اتمی، در پوسته مریخ وجود داشته است. 2

 ) مریخی ها از نظر تکنولوژیکی از انسان هاي کره زمین پیشرفته تر بودند. 3

 ) موجودات مریخی به مانند انسان غذا می خورند.4

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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ارتباط دارد. حالا یک    -7 بیماري هاي قلبی، سکته مغزي و سرطان  ما می دانیم که آلودگی هوا به 

مطالعه جدید که نتایچ آن در ژورنال همتانگر منتشر شده، نشان می دهد که حتی مقادیر کم افزایش  

با افزایش چشم گیر ناراحتی هاي روحی در افراد جوان دارد. محققا ن در آلاینده همبستگی زیادي 

سال را براي این تحقیق، مورد برررسی و پایش قرار دادند. آنها    18هزار فرد زیر    500سوئد، بیشتراز  

غلظت آلاینده ها در هر منطقه را با میزان داروهاي اعصابی که براي کودکان تجویز شده بود، تطبیق  

هایی بودند که افراد جوان    دادند. مکان هایی که میزان آلودگیشان بیشتر شده بود، تقریبا همان مکان

 در آن، بیشترین نسخه ها را براي داروهاي اعصاب دریافت کرده بودند. 

 کدام مورد، در صورتی که صحیح فرض شود، به بهترن وجه، استدلال فوق را تضعیف می کند؟ 

)www.iranestekhdam.ir ( 

) در کشورهاي دیگر ، به ویژه کشورهاي صنعتی، نیز همبستگی بین آلودگی هوا و بیماریهاي اعصاب، نوعی  1

 همبستگی مثبت است. 

) آلودگی هوا احتمالاً تاثیرات منفی بسیاري بر سلامت انسان دارد که هنوز همه آنها به طور دقیق، مشخص  2

 نشده اند.

 ) برخی از ناراحتی هاي اعصاب، با روان درمانی و بدون مصرف دارو قابل علاج هستند.3

کارگري هستند و در انجا، والدین زمان  -) مناطقی از سوئد که آلودگی هوا در آنها زیاد است، مناطقی صنعتی 4

 کمی براي برقراري ارتباط عاطفی با فرزندانشان دارند. 

 

تفکر لزوما متکی به زبان نیست، یا دست کم متکی به زبانی متعارف که قابل تکلم باشد. ما میتوانیم    -8

دست،   و  سر  حرکات  بدنی،  هاي  ژست  بعدي،  سه  الگوهاي  تصاویر،  و  مناظر  کردن  تصور  طریق  از 

ترین  ...............کدام مورد، به منطقی   هیجانات احساسی و هر چیز دیگري که به جز زبان تجربه کرده ایم، 

 ) www.iranestekhdam.ir(  کند؟وجه، جاي خالی در متن فوق را کامل می 

 ارتباط ایجاد کنیم.  )2    زبان را جایگزین کنیم.  )1

 تفکر کنیم.  )4    دانش افزایی کنیم.  )3

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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منظور  ه ( نه لزوما به ترتیب) به درگاه خدمات الکترونیکی قضایی ب  E  ,  D  ,  C  ,  B  ,  Aپنج کاربر با اسامی  

عفو»   درخواست   » و  و «لایحه»  «اظهارنامه»  و  «شکوائیه»  و  ارائه«دادخواست»  پنج خدمت  دریافت 

یک خدمت را دریافت میکند و همزمان با او، کاربر دیگري به این درگاه    مراجعه می کنند. هر فرد دقیقا

مراجعه نمی کند. در خصوص ترتیب مراجعه این پنج نفر و نوع خدمت دریافتی، اطلاعات و محدودیت  

 هاي زیر، در دست است:

1 (C  زودتر ازA  و بعد ازE  کند. که « درخواست عفو» نداده است، به در گاه مراجعه می 

 Dو  Aمراجعه کرده است و نه بین  Dو  Eکه «شکوائیه» اراه نموده، نه بین   B) کاربر2

 است. دقیقا قب از وي به درگاه مراجعه کرده  Dکاربر آخر باشد ،  B) اگر 3

) فردي ك در درگاه، « لایحه» ارائه نموده، دیرتر از کاربر ارائه دنده « اظهارنامه» و قبل از کاربر رائه  4

 کند.کننده «دادخواست» به این درگاه مراجعه می 

، دومین کاربر بین این پنج کاربر باشد که به  درگاه خدمات الکتریکی قضایی مراجعه و «    Dاگر    -9

 درخواست عفو» را ارائه می کند، کدام کاربر، سومین مراجعه کننده به این درگاه است؟ 

)www.iranestekhdam.ir ( 

1 (C        2 (D       

3 (E        4 (A 

 

چنانچه ارائه « لایحه» و « درخواست عفو » به ترتیب، دومین و سومین موردي باشد که در درگاه    -10

خدمات الکترونیکی قضایی ثبت شده است، کدام دو نفر زیر، به ترتیب مراجعه کنندگان چهارم و پنجم 

 )www.iranestekhdam.ir(به این  درگاه هستند؟ 

1 (A  وD       2( D    وB   

3 (C   وD     4 (C    وA 

 

 پاسخ دهید.  12تا  9راهنمایی: با توجه به اطلاعات زیر ، به سوال هاي  

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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با ارائه لایحه، سومین نفري باشد که به درگاه خدمات الکترونیکی قضایی مراجعه می کند،    Cاگر    -11

 ) www.iranestekhdam.ir( خدمت دریافت شده توسط مراجعه کننده پنجم، کدام است؟

   ) دادخواست2     ) شکوائیه  1

 ) عفو 4    ) نمی توان تعیین کرد  3

 

، دو کاربري باشند که دقیقاً پشت سر هم به درگاه خدمات الکترونیکی قضایی مراجعه   E و  Bاگر  -12

 ) www.iranestekhdam.ir(  با کدام ترتیب، به این درگاه مراجعه می کنند؟ Eو  Bمی کنند ، 

 ) سوم و چهارم   2           ) دوم و سوم   1

 ) اول و دوم  4    ) چهارم و پنجم   3

 

و جواب هر سوال را در پاسخنامه   دیرا به دقت بخوان  17تا    13  ي: هر کدام از سوال ها  ییراهنما 

 . دیعلامت بزن

 )www.iranestekhdam.ir(کدام است؟    x+yدر جدول رو به رو ، حاصل  -13

1(10 

2(8 

3(7 

4(11 

 
 

لیتري آب و آب    6در اختیار داریم. یک محلول     %40لیتري آب و شکر به غلظت    4یک محلول    -14

نیز در اختیار داریم. این  دو محلول را با هم ترکیب می کنیم  تا شربت آبلیمو    %30لیمو به غلظت  

 ) www.iranestekhdam.ir( ساخته شود. غلظت شربت آبلیمو، چند درصد است؟ 

1 (34                  2 (35       

3 (36                                      4 (32   

 

6 5 0 3 

4 7 8 2 

9 5 5 4 

8 8 x y 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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اردیبهشت دوشنبه باشد،    10خرداد می گذرد. اگر    15امروز، پس فرداي روزي است که سه هفته از    -15

 ) www.iranestekhdam.ir( فردا چند شنبه خواهد بود؟

 ) پنج شنبه   2  ) چهارشنبه                                1

 ) سه شنبه  4  ) جمعه                                      3

 

بود. تفاضل سن علی   3/ 5به  5سال پیش  10است. این نسبت  4به  5سن علی به دوستش  تنسب -16

 ) www.iranestekhdam.ir(   و دوستش چقدر است؟

1(9                                   2(6   

3(3                                    4(12 

 

مطابق شکل رو به رو ، به مرکز چهار راس یک مربع، چهار دایره یکسان طوري رسم می کنیم  که   -17

دایره اي که به هر چهار دایره  می تواند مماس شود نیز با آن چهار دایره یکسان باشد.چند درصد  

 ) www.iranestekhdam.ir(فرض شود.)  π=3مساحت مربع، هاشور خورده است؟ (

1(40 

2(33 

3(25 

4(50 

 

 پاسخ دهید .  20تا  18راهنمایی: با توجه به اطلاعات و نمودارهی زیر ، به سوالات 

است نمودار « الف» درصد    5و  4و    3و   2و   1شعبه عمومی با شماره هاي    5حوزه قضایی شهري، داراي  

و   «جعل  هاي  پرونده  «ب»درصد  نمودار  و  شعبه  هر  به  خاص  یکسال  در  شده  ارجاع  هاي  پرونده 

 . کلاهبرداري» به کل پرونده هاي ارجاع شده به هر کدام از شعبه ها را در همان سال نشان می دهد

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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ارجاع شده باشد ، چند پرونده غیر از «جعل و    5پرونده « جعل و کلاهبرداري» به شعبه    70اگر  -18

 ) www.iranestekhdam.ir( ارجاع شده است؟  4کلاهبرداري» به شعبه 

1(160      2 (145  

3 (25        4(240 

 

، چند درصد از کل پرونده هاي ارجاع شده  4و    3پرونده «جعل و کلاهبرداري» ارجاعی به شعب    -19

 ) www.iranestekhdam.ir( ها بوده است؟به همه شعبه 

1(5/30      2(25/18 

3(25/15     4(5/36 

 

ارجاعی    -20 از آن، تعداد کل پرونده هاي  ثابت ماندن   %20در سال بعد  با فرض  یافته است.  کاهش 

 5و    1مقادیر دو نمودار « الف» و «ب» چند درصد از پرونده هاي «جعل و کلاهبرداري » که به شعب  

 ) www.iranestekhdam.ir(  بوده  است؟ 1ارجاع شده اند، مربوط به شعبه 

1 (55        2 (45 

3 (25      4 (75   

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
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هاي عمومی هوش و توانمنديپاسخنامه تستی   

 

 گزینه صحیح  شماره سوال  گزینه صحیح  شماره سوال 

11سوال  1   1سوال   2 

2سوال  12سوال  2   4 

3سوال  13سوال  3   1 

4سوال  14سوال  1   1 

5سوال  15سوال  4   3 

16سوال  2   6سوال    2 

7سوال  17سوال  4   3 

8سوال  18سوال  4   1 

9سوال  19سوال  3   2 

10سوال  20سوال  2   4 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE


 

 
 

 

 

 

 

 »محصولات مرتبط دانلودي « 

 ه ییاستخدام قوه قضا یو تخصص  یدانلود نمونه سوالات عموم

 خرید  و دانلود

   یاستخدام  يهادر آزمون  یآمادگ يبراهاي آموزشی دانلود درسنامه

 خرید  و دانلود

 

 

 »محصولات مرتبط چاپ شده « 

 هاي  استخدامی هاي چاپ شده براي آمادگی در آزمون سفارش کتاب 

 و سفارش  ثبت

 

 

 

 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D9%86%D9%85%D9%88%D9%86%D9%87-%D8%B3%D9%88%D8%A7%D9%84%D8%A7%D8%AA-%D9%88-%D9%85%D9%86%D8%A7%D8%A8%D8%B9-%D8%A2%D8%B2%D9%85%D9%88%D9%86-%D8%A7%D8%B3%D8%AA%D8%AE
https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D8%AF%D8%B1%D8%B3%D9%86%D8%A7%D9%85%D9%87-%D9%87%D8%A7%DB%8C-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C
https://ketab.iranestekhdam.ir/


 

 

 

 
 
 
 
 

 
 
 

 

 

 

 

 

 
 

 سرویس خصوصی خدمات عام المنفعه اخبار شغل و استخدام 

Www.IranEstekhdam.Ir 

 

   خود در مورد مطالب آن شنهادیلطفاً هرگونه انتقاد و پ فایل؛  نیا تیفیدر جهت بهبود ک  ؛یخواننده گرام

 : دیینما مطرح  ر یزو یا با شماره تلفن   لیمی اآدرس گزارش مشکل را به یا و 

    soal@iranestekhdam.irآدرس ایمیل:                       021- 91300113شماره تلفن تماس:  

 

 مهم اخطار
 

نزد وزارت ارشاد جمهوري اسلامی ایران ثبت گردیده ؛ لذا  8-596-448-600-978محتواي این فایل به شماره شابک  

هرگونه کپی برداري یا فروش؛ تغییر و دستکاري در محتواي آن مانند حذف آرم یا لوگوي سایت ایران استخدام و یا  

پیگیرد    اضافه کردن آرم؛ نوشته و محتواي دیگر؛ غیر مجاز بوده و متخلف بدون اطلاع قبلی از طریق مبانی قانونی تحت 

 قرار خواهد گرفت. 

 

http://www.iranestekhdam.ir/

